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Введение

«Форвард Спортивные титры» (SLSportTitler) – программно-
аппаратный комплекс, предназначенный для оформления 
титрами трансляций спортивных соревнований в прямом 
эфире. 

Система работает в режиме реального времени. Обеспечива-
ет выполнение следующих функций:

1.	 Управление выводом титров в SLSportTitler:
●● вывод в титрах в эфир статической информации:

●● сведения о чемпионате (название, логотип лиги, 
место проведения, название стадиона);

●● сведения о командах (название, логотип, ФИО 
тренера);

●● сведения об игроках (номер, ФИО, фото, стати-
стика и др.);

●● вывод в титрах в эфир динамической информации о 
ходе игры: 

●● счет;
●● игровое время;
●● номер периода;
●● голы, буллиты;
●● удаления игроков и др.;

●● предварительный просмотр титра для контроля 
перед выдачей в эфир;

●● два режима остановки титра – штатный (с анимаци-
ей) и аварийный.

2.	 Заполнение таблиц базы данных об игре в 
SLSportTeamsEditor:

●● взаимодействие с сайтами спортивных лиг (напри-
мер, KHL) для заполнения базы данных команд;

●● ввод данных об игре и командах из подготовленных 
CSV-файлов;

●● ввод информации вручную.
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3.	 Ввод в систему информации о ходе игры в режиме реаль-
ного времени в программах SL...Referee:

●● взаимодействие с игровым табло стадиона (матч-
контроллером) в реальном времени – автоматиче-
ский вывод динамической информации о ходе игры;

●● ввод динамической информации об игре вручную 
оператором спортивной графики;

●● настройка старта/остановки таймера игрового вре-
мени по внешнему GPI-событию. При изменении 
значений информация в титрах обновляется авто-
матически.

4.	 Графическое оформление дизайна титров. Обеспечива-
ется разработка дизайна в соответствии с требованиями 
спортивных лиг (KHL, FIBA и др.) и собственный дизайн.

Система SLSportTitler представляет собой комплект ПО, ко-
торый устанавливается в компьютер с платой FDExt для на-
ложения графики на проходящее видео либо вывода сигнала 
Fill+Key.

Система поддерживает работу с сигналами в SD и HD-
разрешениях.

Для каждого вида спорта предназначен свой вариант систе-
мы, отвечающий требованиям соответствующей спортивной 
лиги (по содержанию и объему информации, правилам со-
ревнований, дизайну титров и пр).

В настоящее время разработано оформление для разных 
видов спорта:

●● хоккей (дизайн титров удовлетворяет требованиям 
КХЛ);

●● хоккей (собственный дизайн);
●● футбол (собственный дизайн);
●● баскетбол (дизайн титров удовлетворяет требовани-
ям FIBA);

●● баскетбол (дизайн титров удовлетворяет требовани-
ям лиги ВТБ);

●● волейбол (дизайн титров удовлетворяет требовани-
ям CEV);

●● волейбол (собственный дизайн) 
●● гандбол (собственный дизайн);
●● MMA (собственный дизайн, 3 варианта);
●● бокс (дизайн титров удовлетворяет требованиям 
WSB).

Возможна разработка дизайнов титров для других видов 
спорта.
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Общие сведения

Общее описание системы

1. Установка системы
Система «Форвард Спортивные титры» поставляется заказ-
чику в готовом виде для конкретного вида спорта и стадиона 
(чемпионата). Установка системы и настройка ПО произво-
дится специалистами «СофтЛаб-НСК».

2. Системные требования
Системные требования:

1.	 Объем оперативной памяти в системе 16 или 32Gb.

2.	 Версия ПО ForwardT Software и Forward Plugins не ранее 
5.7.1900.

3.	 В систему необходимо установить шрифты, использующи-
еся в дизайне спортивных титров (производится при на-
стройке ПО специалистами компании «СофтЛаб-НСК»).

4.	 Для взаимодействия с игровыми табло стадионов необхо-
димо внести в настройки реестра соответствующие индек-
сы табло (производится при настройке ПО специалиста-
ми компании «СофтЛаб-НСК» для конкретного стадиона 
и его табло).

3. Компоненты системы
Система «Форвард Спортивные титры» (SLSportTitler) скла-
дывается из следующих компонентов:

●● базовый комплект;
●● плагины для отдельных видов спорта по выбору 
(для одного базового комплекта может быть приоб-
ретено любое количество плагинов);

●● варианты дизайнов для выбранных видов спорта 
(ЛАЙТ, ПРО).
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1.1. Базовый комплект системы
В базовый комплект системы входят:

●● Платформа видеосервера в корпусе SuperMicro 4U, 
Microsoft Windows 10 Pro 64Bit;

●● плата ввода/вывода FD722 (SD/HD/3G SDI);
●● набор соединительных кабелей для подключения 
входных/выходных сигналов;

●● программный модуль для ввода в систему информа-
ции о ходе игры в режиме реального времени – обе-
спечивает взаимодействие с игровым табло стади-
она (матч-контроллером) и ввод данных вручную. 
Поддерживается интеграция с матч-контроллерами: 
НАТА-ИНФО, Аранеус, NG-Light, LedBow, Swiss-
Timing, ПАЛАМИ, Nautronic, Stramatel, Dian и 
другими;

●● программный модуль формирования динамиче-
ских титров на основе сцен, созданных в Microsoft 
Expression Blend. 

1.2. Состав ПО плагинов
Для разных видов спорта необходимо использовать разные 
плагины (программные модули, расположенные в папке с 
программой SLSportTitler.exe).

Состав ПО плагинов для разных видов спорта:
●● программные модули и таблицы базы данных для 
соответствующего вида спорта для работы с инфор-
мацией о соревновании: составы команд, сведения 
об игроках, тренерах, судьях, фотографии игроков и 
др.;

●● модули для управления показом титров – рабочее 
место оператора системы. 

1.3. Варианты дизайнов для разных видов спорта
В состав системы входит набор графических файлов с дизай-
ном всех титров, необходимых для графического оформления 
трансляции соревнований выбранного вида спорта. В зави-
симости от требований к объему показываемой информации 
набор титров для определенного вида спорта разрабатывает-
ся в соответствии с требованиями соответствующей спортив-
ной лиги (ассоциации, чемпионата и т.д.).

Помимо графического изображения, дизайн каждого титра 
включает полноценную трехмерную анимацию появления, 
отображения и исчезновения. Эффекты анимации задаются 
дизайнером при разработке оформления. 

Дизайн создается заранее в программе Microsoft Expression 
Blend (как правило, дизайнером из компании «СофтЛаб-
НСК»).
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В составе системы SLSportTitler отсутствуют инструменты 
для самостоятельной разработки и редактирования графиче-
ских элементов оформления. Система поставляется с гото-
вым набором графических файлов в следующих вариантах:

●● Дизайн ПРО – набор графических файлов с дизай-
ном титров для отдельных видов спорта. Оформле-
ние точно соответствует требованиям технического 
регламента соответствующей лиги. Обязательное 
обновление дизайна в случае изменения требова-
ний;

●● Дизайн ЛАЙТ – набор графических файлов с ди-
зайном титров для отдельных видов спорта.

4. Состав ПО и назначение программ
ПО «Форвард Спортивные титры» включает в себя 4 части:

1.	 SLSportDataBaseService – сервер, обеспечивающий рабо-
ту с базой данных.

2.	 SLSportTeamsEditor – редактор базы данных (статиче-
ская информация – текст, фото). 

3.	 SLIceHockeyReferee / SLBasketballFIBAReferee 
/ SLFootballReferee / SLHandballReferee / 
SLVolleyballReferee – программа для интеграции с табло 
или ввода динамической информации вручную (игровое 
время, голы, удаления, буллиты). 

4.	 SLSportTitler – программа управления показом спортив-
ных титров.

5. Схема работы системы «Форвард Спортивные титры»
Система SLSportTitler включает 3 рабочих места:

●● редактирование базы данных с текстовой и графи-
ческой информацией. Рабочее место редактора;

●● ввод игровой информации. Рабочее место судьи;
●● показ титров. Рабочее место оператора спортивной 
графики (титровальщик).

1.	 На этапе подготовки к трансляции заполняется база 
данных в редакторе SLSportTeamsEditor (1). База дан-
ных (файл *.TitleDB) предназначена для хранения инфор-
мации об игроках, судьях, командах и т.д. Ввод данных 
может осуществляться автоматически, путем считывания 
данных с сайта КХЛ и других лиг, из подготовленных 
CSV-файлов или вручную редактором. Помимо текстовой 
информации, в базе данных могут храниться изображе-
ния, например, фотографии игроков.
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2.	 В программе Microsoft Expression Blend (2) заранее созда-
ется пакет графических файлов с дизайном титров (как 
правило, дизайнером из компании «СофтЛаб-НСК»). 
Дизайн делается под конкретный сезон игр конкретного 
вида спорта, с учетом требований соответствующей спор-
тивной лиги (ассоциации, чемпионата и т.д.). 
В программе SLSportTitler создается проект 
*.SLSportTitleCfg (3), в котором задаются все ссылки на 
дизайн и конфигурационные файлы базы данных.

3.	 Плагины для разных видов спорта (SLIceHockeyReferee 
/ SLBasketballFIBAReferee / SLFootballReferee / 
SLHandballReferee / SLVolleyballReferee) (4) – это про-
граммные модули для ввода в систему информации о ходе 
игры в режиме реального времени. Они обеспечивают вза-
имодействие с игровым табло (матч-контроллером) стадио-
на или ввод динамической информации вручную (игровое 
время, номер периода, голы, удаления, буллиты).
Описание и параметры игры (количество периодов и 
их длительность, максимальные количества удалений, 
фолов, таймаутов) задаются заранее в XML-подобном 
файле описания игры. Например, для хоккея это файл 
IceHockey. xml, задаваемый в командной строке программы 
SLIceHockeyReferee.exe.

4.	 В программе SLSportTitler (5) производится управление 
выводом титров на экран. В файле проекта *.SLSportTitleCfg 
сконфигурирован набор кнопок, показывающих опреде-
ленные титры с информацией из базы данных и из про-
граммы ввода динамических данных об игре. 

1

2

4

5

3
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5.	 Источники данных для вывода спортивных титров:
●● база данных, подготовленная заранее для конкрет-
ного чемпионата и конкретной игры;

●● данные с игровых табло.
6.	 Для каждого вида спорта на рабочем столе создаются по 

три ярлыка:
●● SLSportTeamsEditor – база данных игры с соответству-
ющими конфигурационными файлами,

●● SLIceHockeyReferee / SLBasketballReferee / SLFootballRef-
eree / SLHandballReferee / SLVolleyballReferee – с описа-
нием периодов этого вида спорта,

●● SLSportTitler – управление выводом титров с файлами 
дизайна конкретного вида спорта.
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Порядок работы с ПО «Форвард Спортивные титры»

1. Заполнение базы данных в SLSportTeamsEditor
Основная часть информации об игре содержится в базе дан-
ных. Заполнение и редактирование базы данных произво-
дится в редакторе SLSportTeamsEditor, заранее перед транс-
ляцией игры.

1.1. Режимы работы с базой данных
Есть два режима заполнения базы данных:

●● вручную – заполнение данных команд и игроков из 
конфигурационных файлов *.csv в таблицы про-
граммы SLSportTeamsEditor:

●● Игра;
●● Переводы;
●● Информация о первой/второй команде;
●● Игроки первой/второй команды.

●● автоматически – с сайтов спортивных лиг (KHL 
и др.) по кнопке KHL в меню таблиц Информация о 
первой/второй команде. Для корректной работы кноп-
ки KHL необходимо настроить login и password для 
доступа к сайту KHL. 

1.2. Структура базы данных
Показ титров требует очень большого объема памяти. Реко-
мендуется использовать не менее 16 гигабайт оперативной 
памяти. 

Дерево папок с даными на диске выглядит так: в главной 
папке с названием предстоящей игры или чемпионата (на-
пример, KHL-2019) создаются подпапки:

●● Base (1) – в ней размещены все файлы базы данных 
игры и данные игроков команд:

●● Colors;
●● Flags;
●● Logo;
●● Photo;
●● PhotoCOACHES;
●● PhotoPLAYERS;
●● Weather.

●● CSV (2) содержит конфигурационные файлы с та-
блицами данных:
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●● Game Event.csv;
●● GameInfo. csv;
●● TranslateEng.csv;
●● TranslateRus.csv;
●● TeamInfo.csv;
●● TeamPlayers.csv.

●● Design (3) содержит папку со шрифтами Font и под-
папки с графическими файлами оформления ти-
тров:

●● Coach;
●● CountDown;
●● DownScore;
●● Font;
●● GeoTitle;
●● Player;
●● Referees;
●● RefereesNoPhoto;
●● Sostav;
●● Starting;
●● TotalScore;
●● UpScore.

В корне общей папки с названием игры требуется помещать 
файлы проекта *.SLSportTitlerCfg (4) и файл базы данных игры 
и команд *.TitleBD (5).

88 	 Важно: Для корректной работы с изображениями требуется, чтобы 
файл с базой данных (*.TitleDB) и файл с проектом (*.SLSport-
TitleCfg) лежали в одной и той же папке!

1.2. Запуск SLSportTeamsEditor
В системе используется одна текущая база данных на кон-
кретную игру и вид спорта. При смене вида спорта нужно 
обязательно изменить текущую базу данных. Для этого 

1

3
4

5

2
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нужно в соответствующей папке создать новую базу или 
открыть созданную ранее базу и обязательно сохранить ее 
(выбрать меню File > Save или File > Save As). Только после со-
хранения базы можно запускать программы SL...Referee.exe 
и SLSportTitler.exe.

Далее при открытии текущей базы сохранять базу не обяза-
тельно. Достаточно открыть базу и закрыть приложение. 

88 	 Важно: Если в папке с дизайном «Design» есть подпапка «Font», то 
необходимо предварительно установить все шрифты из этой 
папки на компьютер!

Исполняемый файл программы: ~\ForwardT Software\Plugins\SL-
SportTitler\bin\DBEditorSLSBInfo.exe, где ~ – полный путь к пап-
ке, в которую установлено ПО. Чтобы запустить программу, 
используйте команду меню Пуск: ForwardT Software > SL Sport 
Teams Editor или ярлык программы на рабочем столе. В окне 
настроек ярлыка нужно задать уникальную строку, напри-
мер, название вида спорта, чтобы в следующий раз програм-
ма помнила путь к последнему проекту. Разные виды спорта 
будут помнить разные пути, что облегчит работу. -???

При первом запуске откроется окно программы 
SLSportTeamsEditor с пустыми таблицами:
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1.3. Главное окно программы SLSportTimesEditor
При повторном запуске программы открывается база данных 
предыдущей игры. 
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1.4. Конфигурационные файлы CSV
Программа SLSportTeamsEditor cодержит конфигурацион-
ные файлы *.csv, в которых описаны колонки разных таблиц:

●● ИГРА – содержит поля, не зависящие от игрока или 
команды. Здесь сведения о чемпионате, стадионе, 
сезоне, температуре на улице, логотип лиги и дру-
гое. Конфигурационный файл – GameInfo.csv;

●● ПЕРЕВОДЫ – содержит строки, в которых указаны 
все текстовые подписи в разных дизайнах, которые 
не меняются в зависимости от игрока, команды или 
стадиона. В титрах используются надписи, которые 
нужно переводить на русский или английский язык. 

Главное окно программы. Управляющие элементы: 
1 – главное меню; 2 – кнопки быстрого вызова команд базы данных; 3 – таблица со общими све-
дениями об игре; 4 – таблица с переводами текстовых подписей, не меняющихся в зависимости 
от команды или стадиона; 5 – таблица сведений о первой команде; 6 – таблица сведений о второй 
команде; 7 – таблица сведений об игроках первой команды; 8 – таблица сведений об игроках 
второй команды; 9 – загрузка информации о командах из базы данных с сайта KHL; 10 – кнопка 
очистки информации в таблице; 11 – импорт информации из конфигурационного файла *.csv; 
12 – экспорт информации в конфигурационный файл *.сsv; 13 – добавить нового игрока в коман-
ду; 14 – удалить выбранного игрока из команды; 15 – индикатор работы со статистикой FIBA; 16 
– смена языка интерфейса программы.
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Все такие надписи также располагаются в подпапке 
CSV. Русский текст задается в файле TranslateRus.csv, 
а английский – в TranslateEng.csv. При старте про-
граммы и при переключении языка таблица автома-
тически обновляется из соответствующего файла;

●● Информация о первой команде – содержит информа-
цию о первой (слева) команде: название команды, 
логотип, ФИО тренера и другое. Конфигурацион-
ный файл – TeamInfo.csv;

●● Информация о второй команде – содержит информа-
цию о второй (справа) команде. Конфигурационный 
файл – TeamInfo.csv;

●● Игроки первой команды – содержит информацию об 
игроках первой команды: номер, фамилия и имя, 
фото, вес, рост, статистика и другое. Конфигураци-
онный файл – TeamPlayers.csv;

●● Игроки второй команды – содержит информацию об 
игроках второй команды. Конфигурационный файл 
– TeamPlayers.csv.

88 	 Важно: Рекомендуется все надписи делать заглавными буквами!

1.5. Редактирование данных в таблицах
Для работы с конфигурационными файлами *.csv нужно 

нажать на кнопку  в таблицах SLSportTeamsEditor или 
вызвать команду главного меню Редактирование > Импорт из 
файла CSV. Для сохранения данных после редактирования 

нужно нажать на кнопку  или вызвать команду меню 
Редактирование > Экспорт в файл CSV.

Редактирование данных в таблицах можно выполнять прямо 
в программе, по двойному клику по ячейке таблицы. Тексто-
вые данные редактируются встроенным текстовым редак-
тором в ячейке таблицы (1). Чтобы заменить изображение, 
нужно кликнуть в соответствующую ячейку (2), и откроется 
стандартный диалог выбора файла. После выбора в ячейке 
запоминается относительный путь к файлу. Путь указыва-
ется относительно текущего файла базы данных. Поэтому 
сразу после создания новой базы данных нужно сначала 
сохранить ее на диск, а только потом редактировать данные 
в базе.
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1

2

3

В таблицах с информацией об игроках команды есть кнопки 

 и  (3). Кнопка  создает новую строку в таблице, 

а кнопка  удаляет текущую строку из таблицы. Первая 
колонка «#» задает порядок, в котором будут загружаться 
игроки в программе SLSportTitler.

88 	 Важно: После редактирования данных не забудьте каждый раз на-

жимать кнопку  (меню Файл > Сохранить) для сохранения 
информации в базу данных. Не забудьте после редактирова-
ния текстовых данных обязательно кликнуть в любую дру-
гую ячейку, чтобы встроенный текстовый редактор записал 
редактируемые данные в ячейку базы данных.

1.6. Загрузка данных из базы данных KHL

Кнопка  в таблицах Информация о первой/второй команде 
позволяет импортировать статистику для выбранной коман-
ды. Для этого нужно выполнить следующие шаги:

1.	 Настроить доступ к серверу статистики KHL. В главном 
меню выполните команду Редактирование > Настройки. От-
кроется окно Настройки (1).

1

2
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2.	 В полях Пользователь и Пароль (2) нужно указать логин и 
пароль для доступа к сайту сатистики http://stat2tv.khl.ru (их 
необходимо получать у KHL индивидуально). Настройки 
достаточно указать один раз.

3.	 Нажмите кнопку  в таблице Информация о первой 
команде (3). 

3

4.	 Откроется окно выбора команды Импорт из базы данных 
KHL (4). В выпадающем списке (5) выберите язык, кото-
рый используется для отображения информации из базы 
данных. Выберите команду для загрузки ее статисти-
ки (6). Нажмите Импорт (7).

5.	 После импорта необходимо выполнить следующее:
1. Выбрать логотипы команд из папки Base\Logo (1).
2. Выбрать цвета команд (цветной фон под логотип) из 
папки Base\Colors (2).

4

5

6

7
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1 2

3. Указать фамилию и имя тренера команды (заглавны-
ми буквами) (3).

3

4. Удалить из списка «лишних» игроков (не заявленных 
на текущую игру).
5. Указать стартовую пятерку в колонке Pos5 (4). Под 
номером 1 должен быть выбран левый нападающий, под 
номером 2 – центральный нападающий, 3 – правый на-
падающий, 4 – левый защитник, 5 – правый защитник, 
6 – вратарь.

4

6. Сохранить базу, нажав кнопку  или выполнив 
команду главного меню Файл > Сохранить.
7. В процессе игры необходимо заполнять статистику 
команд (5) в таблицах Информация о первой команде и 
Информация о второй команде в колонках Shots, Faceoffs, 
Penalty, Powerplay и Shorthanded (эта информация пока-
зывается в титре «StatGame»), либо не показывать титр 
«StatGame».

5
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6.	 Основной дизайн KHL предполагает использование фото-
графий игроков и тренера. При загрузке информации о 
команде программа загружает в папку Base\PhotoPLAYERS 
все фотографии игроков с сайта KHL. Изображения игро-
ков на сайте хранятся в формате JPG (без прозрачности), 
поэтому отображение в титрах таких фотографий выгля-
дит некрасиво. Рекомендуется преобразовать все фото-
графии в формат PNG с прозрачностью (вырезать фон за 
игроком) и положить PNG-файлы в ту же папку вместо 
JPG-файлов. Все фотографии должны быть высотой 400 
пикселей и шириной не более 400 пикселей (например, 
320х400). На сайте http://stat2tv.khl.ru размещены только 
фотографии игроков, фотография тренера не загружается 
автоматически. Ее нужно скачивать отдельно. Одновре-
менно со скачиванием фотографий рядом с базой создает-
ся CSV-файл с названием команды.

2. Дизайн и анимация титров
Дизайн титров создается заранее в программе Microsoft 
Expression Blend (1) (как правило, дизайнером компании 
«СофтЛаб-НСК»).

3. Описание игры (количество периодов и их длительности) в xml-файле

Описание периодов (количество периодов и их длительности) 
задается в XML-подобном файле описания игры, задавае-

 
1
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мым в командной строке и лежащим рядом с приложением 
SL…Referee.exe. Например, для хоккея это файл IceHockey.xml 
рядом с модулем SLIceHockeyReferee.exe. При загрузке фай-
ла SLIceHockeyReferee.exe появляется окно с уведомлением, 
что файл описания успешно найден:

Формат файла описания игры (например IceHockey.xml) имеет 
следующий вид:
<GameDesc PeriodsCount="7" ReverseTime="true" MaxPenaltyCnt="2">

<Period Duration="20"/>

<Period Duration="20"/>

<Period Duration="20"/>

<Period Duration="5"/>

<Period Duration="1"/>

</GameDesc>

где GameDesc – параметры игры: 
●● PeriodsCount – параметр, задающий количество пери-
одов в игре;

●● Reverse Time – параметр отсчета времени (в мину-
тах):

●● "true" – отсчет времени производится в сторону 
уменьшения (от 20:00 до 00:00);

●● MaxPenaltyCnt – параметр, задающий максимальное 
количество одновременных удалений в игре;

●● Period Duration – длительность периодов в минутах.  
В приведенном примере в игре 7 периодов. Первые 
три периода по 20 минут, четвертый – 5 минут, 
пятый и шестой – по минуте, а последний 7 период 
нужен только для того, чтобы показывать надписи 
по окончанию игры.

Файлы описания игр других видов спорта отличаются по 
параметрам (другое количество периодов и их длительность, 
прямой или обратный отсчет времени, количество таймаутов 
и т.д.).



21

4. Работа в программе SL...Referee
Все программы ввода судейской информации – 
SLIceHockeyReferee, SLFootballReferee, SLBasketballReferee, 
SLVolleyballReferee, SLHandballReferee – обладают следую-
щей общей функциональностью:

●● ввод динамической информации – игровое время, 
номер периода, счет игры, штрафные броски, удале-
ния игроков и др.;

●● взаимодействие с игровым табло (матч-
контроллером) в реальном времени;

●● автоматический старт/остановка игрового времени 
по внешнему GPI-событию.

Интерфейс программ SL...Referee для разных видов спорта 
различается.

Далее рассмотрим порядок работы на примере программы 
SLIceHockeyReferee. 

Примечание: Программа SLIceHockeyReferee применяется для ввода судейской 
информации для хоккея и гандбола.

4.1. Запуск программы SLIceHockeyReferee
Исполняемый файл программы: ~\ForwardT Software\Plugins\
SLSportTitler\bin\IceHockeyReferee\SLIceHockeyReferee.exe, где ~ 
– полный путь к папке, в которую установлено ПО. Чтобы 
запустить программу, используйте команду меню Пуск: For-
wardT Software > SLIceHockey Referee или ярлык программы на 
рабочем столе:

При старте программы названия команд берутся из теку-
щей базы данных, сохраненной последний раз программой 
SLSportTeamsEditor.

4.2. Главное окно программы SLIceHockeyReferee
Например, главное окно программы SLIceHockeyReferee со-
держит следующие блоки для вывода динамической инфор-
мации об игре:

●● область Time&Score info (2) – для управления вводом 
данных о времени, счета в игре (общего и по перио-
дам);

●● область Penalty info (16) – для управления удаления-
ми.
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Главное окно программы. Управляющие элементы: 
1 – главное меню; 2 – область Time&score info для отображения информации о времени и счете 
игры; 3 – поля с названиями команд Team1 и Team2; 4 – область счета игры Score (total and 
period), выпадающие списки Total: – показать распределение голов по периодам и общий счет 
для каждой команды; 5 –  корректировать счет у закончившихся периодов; 6 – область счета игры 
в текущем периоде; 7 – две кнопки + слева и справа – увеличить счет (у обеих команд); 8 – номер 
текущего периода; 9 – обратный отсчет времени периода (бывает прямой отсчет времени у других 
видов спорта); 10 – увеличить/уменьшить игровое время на 1 сек; 11 – стартовать/остановить отсчет 
времени периода; 12 – корректировать время периода (доступно только во время остановки игры); 
13 – открыть окно Shootouts – окно для ввода буллитов; 14 – поставить флажок Empty Net – заме-
на вратаря на еще одного полевого игрока; 15 – поставить флажок Отложенный штраф – отло-
жить время исполнения назначенного штрафа; 16 – область информации об удалениях игроков; 
17 – две кнопки Add Penalty – добавить очередное удаление для соответствующей команды; 18 – 
время удаления в минутах; 19 – таблица со списком удаленных игроков (Team – команда, Time – 
оставшееся штрафное время); 20 – кнопки коррекции времени удаления, выбранного в таблице; 
21 – удалить выбранное удаление.
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4.3. Настройки в программе SLIceHockeyReferee

1

1.	 Команда меню File > Config (1) открывает окно Settings (2)
для настройки автоматического управления временем и 
другими параметрами. В полях Database (3) и Time serv-
er (4) указаны местоположение базы данных и сервера 
времени. Менять их не рекомендуется.

  
     

2

3

4
5

6
7

8

2.	 Если в системе настроено подключение к табло, то можно 
включить флажки:

●● Use score-board‘s time info (5) – использовать данные о 
времени с игрового табло;

●● Use score-board’s score info (6) – использовать данные о 
счете игры с табло;

●● Use score-board’s penalties info (7) – использовать дан-
ные о штрафном времени с табло. 

Включение этих флажков означает включение автома-
тического считывания информации с игрового табло и 
упрощает интерфейс главного окна:
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„„ 	 Совет: Для подключения к табло обращайтесь в службу техпод-
держки «СофтЛаб-НСК».

3.	 Здесь же можно настроить старт/остановку таймера игро-
вого времени по GPI-событиям, вызвав диалог выбора 
GPI-событий кнопкой Config GPI (8) в окне Settings.

4.4. Работа в программе SLIceHockeyReferee

1.	 Для сброса состояния игры в начало выполните команду 
главного меню File > Restart (1).
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1

2.	 Далее рассмотрим работу оператора в ручном режиме 
ввода данных. 
При старте программы названия команд берутся из теку-
щей базы данных, сохраненной последний раз програм-
мой SLSportTeamsEditor.
В главном окне программы в полях Team1 и Team2 автома-
тически появятся названия играющих команд (2). 

3.	 Для старта игрового времени нажмите кнопку Start (3) – в 
период отсчета времени периода она будет отображаться 
как Stop. В поле Time начнется обратный отсчет времени 
текущего периода (4).

    

   

4 8 3

2

57

Чтобы скорректировать игровое время, нажмите Correct 
time (5). Откроется окно Correct time (6):

6
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В этом окне изменить время можно только, когда игра 
остановлена. Кнопки – (7) и + (8) слева и справа от теку-
щего времени позволяют уменьшить/увеличить текущее 
время на одну секунду прямо во время игры.

4.	 В области Score (total and periods) (1) расположены выпада-
ющие списки общего счета Total (2) и распределение голов 
по периодам каждой команды P1, P2, P3 (3).

  

   

4

3
2

1

Чтобы внести изменения в счет, нажмите кнопку Cor-
rect (4). Откроется окно Correct score (5):

5

Внесите изменения в счете в полях Team1 или Team2 в 
текущем периоде. Нажмите ОК.

5.	 В области Score in period (1) в полях (2) введите счет в 
текущем периоде с помощью стрелок счетчика (3), либо с 
помощью кнопок – (4) или + (5).

88 	 Важно: Обратите внимание, что это счет только в текущем периоде, а 
не во всей игре!
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6.	 В области Period (6) в поле (7) введите номер текущего 
периода с помощью кнопок – (8) или + (9).

7.	 Чтобы включить диалог управления буллитами, нажмите 
кнопку Shootouts (1).

 

1

Откроется окно Shootouts (2).

2

3 4 5
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При заполнении таблицы буллитов каждой команды в 
полях Shootout 1...5 укажите результаты в каждом броске:

●● Init (3) – бросок еще не производился;
●● Hit (4) – попадание в ворота;
●● Miss (5) – пропущен.

Изначально перед серией буллитов в титры выводятся 
значки Init – (3). При попадании в ворота в титрах 
загорается флажок Hit –  (4), если бросок не достиг 
ворот, загорается Miss –  (5).

45

8.	 В блоке управления удалениями Penalty info (1) при 
штрафной ситуации в выпадающем списке укажите тре-
буемое время удаления (2, 4, 5, или 10 минут) и нажмите 
кнопку Add penalty (3) соответствующей команды. Ниже в 
таблице появится строка с названием команды и штраф-

3
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ным временем (4). Сразу начинается обратный отсчет 
времени.

   

   
     

5

32
1

4

Чтобы скорректировать штрафное время, выделите стро-
ку в таблице (4). Кнопки Correct time (5) и соответственные 
– (6) и + (7) слева и справа станут активными:

   

   
     

85

76

4

С помощью кнопок – (6) или + (7) измените время удале-
ния игрока.
Чтобы удалить строку штрафного времени в таблице, 
выделите нужную строку и нажмите кнопку Remove pen-
alty (8).

В хоккее титры UpScore и Bullits автоматически изменяют 
данные в текущем изображении при изменении игрового 
времени, номера периода, числа голов, удалении игроков 
или буллитов (shootouts). Остальные титры не меняют изо-
бражения при изменении соответствующих данных в про-
грамме SLIceHockeyReferee, поэтому для отображения новых 
данных нужно убрать титр из эфира и показать его снова с 
новыми данными.
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5. Работа в программе SLSportTitler

5.1. Общая информация о программе SLSportTitler
Управление показом титров производится в программе 
SLSportTitler. Для трансляции игры сохраняется проект *.SL-
SportTitleCfg со всеми выше описанными настройками:

●● в базе данных (SLSportTeamsEditor);
●● в программе для ввода динамической информации 
SL...Referee (время, счет, голы, удаления и т.д.);

●● указаны пути к папкам с графическими файлами 
дизайна титров. 

Интерфейс программы позволяет одной кнопкой (одним или 
двумя кликами) показать готовое экранное поле (титр). Для 
каждого вида спорта настраивается проект с конкретным на-
бором кнопок и дизайном. Например, для хоккея:

1

Каждая кнопка показывает конкретный титр (одну экран-
ную форму), в которой нужные поля заполнены текущими 
данными из базы данных или информацией из программы 
ввода динамических данных. Кнопка может находиться в 
одном следующих состояний:

●● Серая – титр выключен (1);
●● Красная – титр готовится к показу (2) и показывает-
ся в окне предварительного просмотра (3);
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3

2

●● Зеленая – титр готов к показу в эфире или уже по-
казывается в эфире (4).
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4

5

6

8 7

Нормальное состояние кнопки – серое. По первому щелчку 
на кнопку она становится красной и показывает титр в окне 
предварительного просмотра. По окончанию анимации в 
окне предварительного просмотра обычно кнопка меняет 
цвет на зеленый, что означает, что титр готов к показу – 
можно нажимать кнопку Take (5) для выдачи титра в эфир. 
Некоторые кнопки могут автоматически выдавать титр в 
эфир без показа в окне предварительного просмотра, напри-
мер, кнопка UpScore (6) (показ верхнего счета в хоккее). По 
следующему щелчку по кнопке (или по команде Stop all (7)) 
титр уходит из эфира. По команде Abort all (8) титр просто бы-
стро гаснет (выполняется FadeOut без выполнения финаль-
ной анимации).

5.2. Запуск программы SLSportTitler
Исполняемый файл программы: ~\ForwardT Software\Plugins\SL-
SportTitler\bin\Titler\SLSportTitler.exe, где ~ – полный путь к папке, 
в которую установлено ПО. В командной строке нужно ука-
зывать путь к титровальному проекту *.SLSportTitleCfg. Чтобы 
запустить программу, используйте команду меню Пуск: For-
wardT Software > SLSport Titler или ярлык программы на рабо-
чем столе:

При старте программы названия команд берутся из теку-
щей базы данных, сохраненной последний раз программой 
SLSportTeamsEditor.
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5.3. Главное окно программы SLSportTitler
Интерфейс главного окна, состав кнопок-титров формируется 
в зависимости от ранее заполненной базы данных об игре и 
командах в SLSportTeamsEditor и настроек в программе SL...
Referee (вида спорта и соответствующих титров для транс-
ляции). Рассмотрим главное окно SLSportTitler для трансля-
ции хоккейного матча KHL.
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Главное окно программы. Управляющие элементы: 
1 – главное меню; 2 – вкладка Main с кнопками-титрами для трансляции игры для каждой 
команды; 3 – показать титр Sostav – список игроков одной из команд; 4 – показать титр Start-
ing – стартовая пятерка одной из команд; 5 – показать титр Coach – главный тренер одной 
из команд; 6 –  показать титр Dressing room – раздевалка одной из команд; 7 – показать титр 
TimeOut – время вне игры; 8 – показать титр UpScore – счет в текущем периоде; 9 – показать 
титр Player – фото и имя игрока; 10 – показать титр PlayerPenalty – фото и имя игрока, выполня-
ющего штрафной бросок; 11 – показать титр PlayerNoPhoto – имя игрока без фото; 12 – показать 
титр Guest – имя гостя матча; 13 – показать титр Timer – время текущего периода; 14 – таблица со 
списком игроков первой команды; 15 – таблица со списком игроков второй команды; 16 – флажок 
Play – выделить всех игроков (в каждой команде), участвующих в игре; 17 – Update data – обно-
вить данные в таблицах команд (при изменениях в базе данных SLSpotrTimesEditor); 18 – окно 
предпросмотра выбранного для трансляции титра; 19 – область с кнопками-титрами с общими 
данными об игре; 20 – показать титр DownScore – счет игры внизу экрана; 21 – GeoTitle – титр 
с названием чемпионата и команд, их городами и логотипами; 22 – Referees – титр с судьями 
матча (имена, фото); 23 – RefereesNoPhoto – титр с судьями матча без фото; 24 – показать титр 
TotalScore – общий счет игры.
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5.3. Таблица назначения команд главного меню программы SLSportTitler

Таблица.	 Команды главного меню 

Команда меню Действие

1. File – команды для создания и сохранения файла проекта показа титров .
New Создать новый проект (файл *.SLSportTitleCfg).
Load Загрузить созданный ранее проект.
Save (Ctrl+S) Сохранить текущий проект в тот же файл.
Save as... Сохранить текущий проект в новый файл.
Start Запустить начало показа титров.
Stop Остановить показ титров.
Exit (Alt+F4) Завершить работу с программой.

2. Options – команды для настройки интерфейса показа титров. 
Grid configurations Открыть окно Grid configuration – задание параметров сетки 

для расположения кнопок интерфейса:
Rows count – количество горизонтальных строк; 
Columns count – количество столбцов.

Configure tabs Открыть окно Tab configurations для создания/удаления 
вкладок с комплектом кнопок-титров для трансляции 
игр. 

Configure views Открыть окно View plug-ins config для настройки таблиц со-
става команд.

Configure buttons Открыть окно Title plug-ins config – для настройки набора 
кнопок титров на вкладке (Sostav, Coach, DressingRoom, 
TimeOut, UpScore, Bullits, Player и др.)

Configure special buttons Открыть окно Special buttons config – для настройки горячих 
клавиш и GPI-событий для команд управления выдачей в 
эфир подготовленных кнопок-титров:
StopAll – остановить показ всех тиров; 
AbortAll – Escape – титр быстро гаснет (FadeOut) без выпол-
нения анимации; 
Take – F1 – вывести титры в эфир.

Configure preview Открыть окно Preview configuration – для настройки разме-
ров окна предпросмотра титров.

Options Открыть окно Options configuration – для настройки цветов 
отображения статуса показа титров, а также для выбора 
устройства отображения в списке Board type (выбрать до-
ступную плату FDExt).

3. Group’s commands – команды для показа групп титров.  
Stop default group Остановить показ текущего титра в группе титров по умол-

чанию.
Stop group 1 Остановить показ текущего титра группы 1.
Stop group 2 Остановить показ текущего титра группы 2.
Stop group 3 Остановить показ текущего титра группы 3.
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Команда меню Действие

Abort all Остановить показ титра без выполнения анимации, через 
угасание FadeOut.

Stop all Завершить показ титра.
Take Запустить показ титра в эфире.
Use global short cuts Включает синхронный режим работы горячих клавиш 

для всех программ системы.

5.4. Настройка параметров интерфейса программы SLSportTitler
1.	 Чтобы произвести изменения в настройках интерфейса 

программы SLSportTitler, выполните команду главного 
меню File > Stop. Настройки программы выполняются в 
меню Options (1). Как правило, система поставляется с уже 
готовыми настройками. 

1

2

4

2.	 Команда Configure grid (2) открывает окно Grid configura-
tion (3) для настройки размерной сетки для расположения 
кнопок-титров. По умолчанию в программе задана сетка 
20х6. Rows count – количество горизонтальных рядов, Col-
umns count – количество вертикальных столбцов.

3

3.	 Команда Configure tabs (4) открывает окно Tab configura-
tion (5) для создания/удаления (кнопки Add (8) и Re-
move (9)) вкладок с набором кнопок-титров. В поле Title (7) 
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введите название вкладки. Все вкладки отобразятся в 
списке (6).

5

6

7

8 9

4.	 Команда главного меню Options > Configure views открыва-
ет окно View plug-ins config (10) – настройка взаимораспо-
ложения элементов интерфейса окна по сетке. Кнопка 
Show config (11) открывает окно Player view config (12) – для 
настройки конфигурации таблиц со списками команд 
(Name, Role, +)(13) и ссылкой на базу данных игры (14). 

10

11
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12

13

14

5.	 Команда главного меню Options > Configure buttons открыва-
ет окно Title plug-ins config (15) – для настройки кнопок-ти-
тров: их список (16), расположение на вкладке програм-
мы (17), название кнопки-титра Name (18), номер группы 
титров Group number (19), Processor number (20) – количество 
ядер процессора, которые будут использоваться для гене-
рации этого титра, настройки горячих клавиш (21), GPI-
событий (22), а также список типов титров Title plug-in (23) 
– чаще всего Static info title plug-in, показывает состояние 
данных в момент нажатия кнопки.
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16 17
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24
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Нажмите Show config (24). В зависимости от выбранного 
типа титра в списке Title plug-in (23) откроются разные окна 
настройки. Например, Goal plug-in configuration (25).

23

25

●● FIBA time title plug-in – показ динамической информа-
ции в баскетболе;

●● FIVB title plug-in – показ динамической информации в 
волейболе;

●● Goal title plug-in – показ динамической информации в 
хоккее/гандболе;

●● PlayerShots title plug-in – показ поля бросков в дизайне 
FIBA;

●● Shootouts title plug-in – показ буллитов в хоккее;
●● Static info title plug-in – настройка любых параметров в 
статическом виде (данные берутся в момент нажа-
тия кнопки и не меняются при показе).

6.	 Команда главного меню Options > Configure special buttons 
открывает окно Special buttons config (26) для настройки 
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горячих клавиш для команд главного меню (27): StopAll, 
AbortAll, StopDefault, StopGroup1...3, Take и GPI-событий (28). 

26

27

28

7.	 Команда главного меню Options > Configure preview от-
крывает окно Preview configuration (29) для настройки 
пропорций окна предпросмотра титров (30). Span – это 
количество рядов/колонок, занятых одной кнопкой. Row – 
координата левого верхнего угла окна сверху (номер 
верхнего ряда), Row span – высота окна, Column – коорди-
ната левого верхнего угла слева (номер столбца слева), 
Column span – ширина окна.

29



40

30

8.	 Команда главного меню Options > Options открывает окно 
Options configuration (28) для настройки цвета разных со-
стояний кнопок-титров (29), а также для выбора устрой-
ства отображения Board config (30) – платы ввода-вывода 
FDExt.

●● Красный Running state color – титр генерируется для 
начала показа (еще не готов к показу);

●● Зеленый Stopping state color – титр закончил гене-
рацию для начала показа (уже готов к показу) и 
генерирует данные для окончания показа;

●● Синий Run state color – титр динамический, он уже 
прошел этап Running и еще не начинал Stopping.

28

29

30
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5.5. Управление показом титров 
1. При запуске программы SLSportTitler открывается ранее 
настроенный титровальный проект *.SLSportTitlerCfg (в про-
граммах SLSportTeamsEditor и SLIceHockeyReferee). Либо 
воспользуйтесь командой главного меню File > Load и открой-
те требуемый проект.

2.	 Чтобы запустить показ титров, выполните команду глав-
ного меню File > Start (1). 

3.	 В таблицах команд обновите списки игроков, участву-
ющих в предстоящей игре. Для этого в столбце Play по-
ставьте или уберите флажки игроков (1).

1
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1

3 42

1

Для сортировки отображения списков используйте кнопки:
●● № (2) – сортировка списка игроков по номерам в по-
рядке возрастания;

●● Name (3) – сортировка списка игроков по именам в 
алфавитном порядке;

●● Role (4) – сортировка списка игроков по амплуа – 
вратари GOALTENDER, нападающие FORWARD, за-
щитники DEFENSEMEN.

Для обновления данных нажмите Update data (5).

4.	 Чтобы вывести в эфир титр Sostav, нажмите на соответ-
ствующую кнопку-титр (6). Красный цвет означает, что 
титр готовится к трансляции и показывается в окне пред-
варительного просмотра (7) с заданной анимацией.
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6

7

По окончании анимации в окне предварительного про-
смотра кнопка Sostav поменяет цвет на зеленый (8). Это 
означает, что титр готов к показу. 

8 91011

Нажмите кнопку главного меню Take (9) для выдачи ти-
тра в эфир.

5.	 Остановить показ титра можно несколькими способами:
●● кликните по кнопке титра еще раз;
●● выполните команду главного меню Stop all (10) – 
титр исчезает с финальной анимацией;

●● выполните команду главного меню Abort all (11) – 
титр просто быстро гаснет (через затухание FadeOut 
без финальной анимации).

6.	 Некоторые кнопки могут автоматически выводить титр в 
эфир без показа в окне предварительного просмотра. На-
пример показ верхнего счета UpScore (12) или Timer (13).
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12

13
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Интерфейс ПО «Форвард Спортивные титры»

Команды редактора базы данных SLSportTeamsEditor

Настройка и управление заполнением таблиц базы данных 
игры производится с помощью команд главного меню или 
кнопок на панели инструментов каждой таблицы редактора.

Таблица.	 Команды программы

Команда меню Кнопка на панели  
инструментов/в окне 

Действие

1. Файл – команды для создания и сохранения базы данных об игре.
Новый Создать новую игру.

Открыть Загрузить информацию из базы 
данных (файл *.TitleDB).

Сохранить (Ctrl+S) Сохранить информацию в базу дан-
ных.

Сохранить как...   Сохранить информацию в базу дан-
ных в новый файл.
Мониторить состояние игры FIBA.

Выход (Alt+F4) Завершить работу с программой.
2. Редактирование – команды для заполнения таблиц с данными об игре, коман-
дах, игроках. 

Таблица ИГРА
Очистить Очистить информацию об игре.

Сбросить информацию о 
времени

Запустить/остановить отсчет игро-
вого времени. 

Импорт из файла CSV Импорт информации об игре из 
файла *.csv.

Import information аbоut teams and 
players from FIBA log-file.
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Команда меню Кнопка на панели  
инструментов/в окне 

Действие

Экспорт в файл CSV Экспорт информации об игре в файл 
*.csv.

Таблица ПЕРЕВОДЫ 
Очистить Загрузить переводы по умолчанию.

Импорт из файла CSV Импорт переводов из файла *.csv.

Экспорт в файл CSV Экспорт переводов в файл *.csv.

Таблица «Информация о первой команде»
Очистить Очистить информацию о первой ко-

манде.

Импорт из файла CSV Импорт информации о первой ко-
манде из файла *.csv.

Импорт из базы данных КХЛ Получение информации о команде 
и игроках первой команды из базы 
данных KHL.

Экспорт в файл CSV Экспорт информации о первой ко-
манде в файл *.csv.

Таблица «Информация о второй команде»
Очистить Очистить информацию о второй ко-

манде.

Импорт из файла CSV Импорт информации о второй ко-
манде из файла *.csv.

Импорт из базы данных КХЛ Получение информации о команде 
и игроках второй команды из базы 
данных KHL.

Экспорт в файл CSV Экспорт информации о второй ко-
манде в файл *.csv.

Таблица «Игроки первой команды»
Очистить Очистить информацию об игроках 

первой команды.

Импорт из файла CSV Импорт информации об игроках 
первой команды из файла *.csv.

Экспорт в файл CSV Экспорт информации об игроках 
первой команды в файл *.csv.

Добавить нового игрока в первую 
команду. 
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Команда меню Кнопка на панели  
инструментов/в окне 

Действие

Удалить выбранного игрока из пер-
вой команды. 

Таблица «Игроки второй команды» 
Очистить Очистить информацию об игроках 

второй команды.

Импорт из файла CSV Импорт информации об игроках 
второй команды из файла *.csv.

Экспорт в файл CSV Экспорт информации об игроках 
второй команды в файл *.csv.

Добавить нового игрока во вторую 
команду. 

Удалить выбранного игрока из вто-
рой команды. 

Настройки Открыть окно Настройки для обеспе-
чения доступа к сайту статистики 
КХЛ (http://stat2tv.khl.ru).

3. Справка – данные о программе.
О программе... Вызов окна со справочной информа-

цией, в том числе с информацией о 
версии ПО системы «Форвард Спор-
тивные титры».
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Полезные ссылки

© СофтЛаб-НСК

Линейка продуктов ФорвардТ: описание, загрузка ПО, документация, гото-
вые решения
http://www.softlab-nsk.com/rus/forward

Техподдержка 
e-mail: forward@sl.iae.nsk.su

	  forward@softlab-nsk.com

	  forward@softlab.tv

Форумы 
http://www.softlab-nsk.com/forum

Документы, рекомендованные для дополнительного ознакомления:

FDPostPlayCapture. Ввод аудио- и видеоданных в хранилища, работа с хранилища-
ми при использовании плат FD322, FD422, FD842

http://www.softlab-nsk.com/rus/forward
http://www.softlab-nsk.com/forum
http://www.softlab.tv/rus/forward/docs/ru_postplay_capture.pdf
http://www.softlab.tv/rus/forward/docs/ru_postplay_capture.pdf

	Введение
	Общие сведения
	Общее описание системы
	1. Установка системы
	2. Системные требования
	3. Компоненты системы
	1.1. Базовый комплект системы
	1.2. Состав ПО плагинов
	1.3. Варианты дизайнов для разных видов спорта

	4. Состав ПО и назначение программ
	5. Схема работы системы «Форвард Спортивные титры»


	Порядок работы с ПО «Форвард Спортивные титры»
	1. Заполнение базы данных в SLSportTeamsEditor
	1.1. Режимы работы с базой данных
	1.2. Структура базы данных
	1.2. Запуск SLSportTeamsEditor
	1.3. Главное окно программы SLSportTimesEditor
	1.4. Конфигурационные файлы CSV
	1.5. Редактирование данных в таблицах
	1.6. Загрузка данных из базы данных KHL

	2. Дизайн и анимация титров
	3. Описание игры (количество периодов и их длительности) в xml-файле
	4. Работа в программе SL...Referee
	4.1. Запуск программы SLIceHockeyReferee
	4.2. Главное окно программы SLIceHockeyReferee
	4.3. Настройки в программе SLIceHockeyReferee
	4.4. Работа в программе SLIceHockeyReferee

	5. Работа в программе SLSportTitler
	5.1. Общая информация о программе SLSportTitler
	5.2. Запуск программы SLSportTitler
	5.3. Главное окно программы SLSportTitler
	5.3. Таблица назначения команд главного меню программы SLSportTitler
	5.4. Настройка параметров интерфейса программы SLSportTitler
	5.5. Управление показом титров 



	Интерфейс ПО «Форвард Спортивные титры»
	Команды редактора базы данных SLSportTeamsEditor


